
Windows 8 Features  
(http://www.dummies. com/how-to/content/windows-8-for-dummies-cheat-sheet .html) 

Five Big Changes in Windows 8 
Windows 8 looks and behaves much differently from previous versions of Windows. Remember these 

five big changes, and you'll be well prepared for Windows 8. 

Windows 8 behaves much like a large smartphone or tablet.  

If you've been using a tablet or smartphone — those fancy cellphones with Internet access — 

you might feel right at home. When you turn on your computer, Windows 8 looks much like a 

large-screen tablet smartphone. Instead of seeing icons, though, you see large tiles representing 

each program. That large, tile-filled screen has replaced the Start menu, and it's called the Start 

screen. You'll return to it constantly to launch programs. 

Programs are now called apps. 

 In keeping with the smartphone theme, Windows 8 now refers to all programs as apps – short 

for applications. You can easily install new apps by downloading them from Microsoft's Store 

app. 

The desktop is now an app.  

Windows 8 refers to the traditional Windows desktop as an app. So, when you want to work the 

way you did in earlier versions of Windows, you click the Desktop tile on the Start screen. The 

familiar desktop appears, letting you run your familiar programs in their own windows. The 

Desktop app looks almost identical to the desktop in Windows 7. (Windows 8 uses the word app 

to describe desktop programs, too.) 

Windows 8 works very well on touchscreens.  

When running Windows 8 on a touchscreen, substitute the word "tap" for click, and you'll get 

along just fine. To right-click when using a tablet, hold your finger down on the item. When a 

box appears, lift your finger. The right-click menu appears, ready for you to tap your desired 

option. 

The Charms bar brings everything together.  

One of the most pervasive changes in Windows 8, the Charms bar, lives throughout Windows 8, 

both on the desktop and on the new Start screen. You need to summon the Charms bar to 

search for things, share things with friends, send things to devices like printers, or change an 

item's settings. 

  



Windows 8 Touch and Mouse Commands 

Windows 8 brings users into a new era of touchscreens, whether they're built into tablets, laptops, or 
even desktop monitors. When faced with a touchscreen device, these commands will help you 
maneuver through Windows 8. (The term swipe simply means to slide your finger along the screen.) 

Swipe from the right edge to see system commands: Swiping from the right side of the screen 
reveals the Charms bar. The Charms bar contains five icons that let you choose how to deal with 
you're seeing onscreen. You can Search its material, Share it with others, return to the Start screen, 
send it to a Device (a second monitor or a printer), or see Settings for that particular item. 

Mouse equivalent: Place the mouse pointer in the upper- or lower-right corner of the screen 
to summon the Charms bar and then click the desired icon: Search, Share, Start, Device, or 
Settings. 

Swipe from the left edge: Swiping from the left brings up your last used app. Also, swipe in 
from the left and then slide your finger back slightly to the edge; your previously used apps cling to 
the left edge as a strip, letting you tap the one you wish to revisit. 

Mouse equivalent: Place mouse pointer in upper-left corner to see last used program or app; 
slide the mouse down the left edge to see other recently used programs. Click the app or 
program to bring it to the forefront. 

Press and hold: You can see detailed information without having to commit to an action. In some 
cases, pressing and holding opens a menu with more options. 

Mouse equivalent: Hover over an item to see more options; if that doesn't work, click the 
mouse's right button. 

Tap to perform an action: Tapping something causes an action, such as launching an app, 
following a link, or performing a command. 

Mouse equivalent: Click an item to perform an action. 

Slide to drag: This is mostly used to pan or scroll through lists and pages, but you can use it for 
other interactions, too, such as moving an object or for drawing and writing. 

Mouse equivalent: Click, hold, and drag the item. A scroll bar often appears at a screen's 
edge, letting you shift your view by dragging the box embedded in the scroll bar. 

Pinch or stretch: Place two fingers on the screen and then move them as if you were pinching or 
stretching a sheet of paper. The onscreen image expands or shrinks accordingly. 

Mouse and keyboard equivalent: Hold down the control key on the keyboard while using the 
mouse wheel to grow or shrink an item on the screen. 



Rotate to turn: Hold down two fingers onscreen and rotate them, just as if you were moving a 
sheet of paper on your desktop. As your fingers move, so does the onscreen object. 

Mouse equivalent: None. 

Swipe from the bottom or top edge for app commands: App commands are revealed by 
swiping inward about an inch from the bottom or top edge. Swiping from the very top to the very 
bottom of the screen lets you close the current app. 

Mouse equivalent: Right-click a blank portion of the app to see the apps commands. 

  



Office 2013  
(http://www.pcworld.com/article/2012663/10 -awesome-new-additions-in-off ice-2013.html)  

10 awesome new additions in Office 2013 

1. Modern Style Interface 

In keeping with the “Modern” (previously called "Metro") style interface that you'll see in Windows 
8, Office 2013 is getting a new  look. Gone are the multiple shades of color that decorated the older 
interface, as well as the shadows and shading that suggested three dimensions. Instead, everything 
is minimalist, flat, and stark—mimicking the tiles on the Windows 8 start screen. The only hint of 
frivolity exists in a watermark design in the top right corner of the screen. The idea is that the new 
look will help you focus on your work rather than being distracted by the objects decorating your 
screen. Whether the redesign will achieve this goal or not—time will tell one way or the other—I 
certainly like the crisper look.  

2. Start Screens 

Each app supports a new color-coded start screen—blue for Word, green for Excel, orange for 
PowerPoint, green for Publisher. Like the other applications' start screens, the one for Word displays 
a list of recent documents. Though creating a blank document is the default option, you can 
alternatively select a template, search online for templates, or click Open Other Documents to 
search for a document on disk or in a SkyDrive folder. These screens will help new users find their 
way around more easily, and experienced users will appreciate having all of their options in one 
place at startup. The top right of the screen shows details of the SkyDrive account that you are 
currently logged in to use.  

3. SkyDrive Integration 

Office 2013 is designed to integrate with the cloud—with SkyDrive and SharePoint, in particular. 
That's good news if you prefer to save your work online for anywhere-access, though most small 
businesses and individuals still save files locally. If you use SkyDrive, the account details wil appear in 
the top left corner of all the application screens, as well as on their start screens. Click your account 
details to switch accounts and to manage them. When you save a document, worksheet, or 
presentation, the application will default to saving to your SkyDrive account, but you can save to 
your local disk if you wish.  

4. Syncing Across Devices 

When you save your Office documents online, they’ll be available to you (and others) from any 
device at any time, via Office 2013 on a PC or tablet, or via the WebApps. Microsoft has already 
upgraded the WebApps for Word, Excel, OneNote, and PowerPoint with the new Modern-style look 
and Office application color coding. In addition, Word, Excel, and PowerPoint will save the last 
location where you were working before you saved--down to the letter, cell, or image. This feature 



makes it easier to pick up where you left off working, even if you open the file on a different device 
than you last used.  

5. Touchscreen use 

Some new Office 2013 features are designed to make working with a touchscreen easier. The new 
Read Mode in Word opens a document in reading view, which lets you scroll through the document 
by swiping horizontally with your finger. On a desktop with a touchscreen monitor, you can change 
this behavior back to the more traditional page navigation mode if you wish. Click the Touch Mode 
button on the Quick Access Toolbar—to the right of the program logo of each application—and the 
ribbon toolbar spreads its icons further apart for easier access to fingers.  

Apart from these useful changes, however, touch integration in Office is somewhat erratic. You can 
use gestures such as tap, pinch, stretch, slide, and swipe for various features. But on a 24-inch 
touchscreen monitor, unfortunately, the text formatting icons were too small for me to use 
accurately. So, right now, though the suite is usable on a touchscreen device—which is a step in the 
right direction—it is still far from touch-friendly.  

6. PDF Editing 

In the past you could save a Word document as a PDF file, but until now you couldn't edit PDFs in 
Word without first converting them to Doc or DocX format. The new Word 2013 can open PDF files, 
edit them there, and then save them as either DocX files or PDFs. When opened in Word, the file 
retains the structure of the PDF file, even for elements such as tables. This advance will be a big plus 
for many users, who can simplyopen a PDF and get straight to work.  

7. Formatting Task Panes in PowerPoint 

Formatting images, shapes, and other objects in PowerPoint is now more intuitive. Right-click an 
image and choose Format Picture to open the new Format Picture task pane, which shows the 
formatting options available for that object. Click another object, and the options in the task pane 
change to show only the options available for that object. You can leave the pane open as you work, 
so that it’s visible without cluttering your workspace.  

8. Easier Charting 

For users confused by the plethora of charting options in previous versions of Excel, the new 
Recommended Charts feature is useful. Select the data to chart and click Insert > Recommended 
Chart to see options such as line, bar, and pie charts that the program recommends for your data. 
Click each chart to preview what your data will look like in that form. After you select and create a 
chart, small icons will appear outside its top right corner when you select it, giving you access to 
work with chart elements, styles, and colors, and with the chart data itself.  

9. More Graphics Options 

In Word, PowerPoint, Excel, Publisher, and even Outlook, new icons on the Insert tab of the ribbon 
toolbar let you insert pictures from your local PC or from various online sources. The online options 



include inserting images within the Office Clipart collection online, via a Bing search, or from your 
own SkyDrive or Flickr account. (To access your Flickr account, you must first need to authorize 
Office to connect to it.)  

10. Account Login 

The Backstage View in Office 2013 applications (accessed via the File tab) includes a new tab called 
Account (or 'Office Account', in Outlook). Here you can log in to your SkyDrive account or switch 
accounts. You can also see a list of connected services, such as Twitter and Facebook, and add 
services, such as LinkedIn and SkyDrive. The Office Updates area gives you information about the 
status of any available updates. Click Update Options to disable or enable updates and to view a 
history of Office 2013 updates.  

 

Versions of Office 2013 
 

Microsoft Office Home and Student 2013 ($139) 

Microsoft Office Home and Business 2013 ($219) 

 

This license is a standalone versions of Office 2013.  The license is perpetual and does not 

include updates.  This license is only good for one computer per license. 

Office 365 Home Premium ($99/year) 

Office 365 Small Business Premium ($150/year) 

Office 365 University ($40/year with a minimum 2-year subscription) 

 

This license is an annual license fee that renews each year.  New updates and versions of Office 

are automatically included.  You are allowed to install it on up to 5 machines with multiple users 

per machine.  It includes an additional 20GB of online storage in SkyDrive (above and beyond 

the 7GB with a free SkyDrive account).  The extra storage is only available to the person who 

registers the software.  You also get 60 free Skype minutes a month.  You also get access to 

Roaming Apps (Word, Excel, PowerPoint, Publisher, Access, and InfoPath).  This is basically a 

way to work on your Office documents on computers that don’t have Office installed. 


